What's New in
Borland JBuilder 7
®

Introduction
Borland® JBuilder™ 7 contains major improvements in developer

™

productivity, as well as a cleaner, more intuitive user interface and

Improve developer productivity,
enhance performance

dramatic performance enhancements.
Specific areas of change are as follows:
•

Productivity enhancements
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•

Build system

•

Runtime configurations
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•

Tool configurations

•

Debugger

•

UML™ code visualization

•

JBuilder Test Runner

•

Refactoring

•

Javadoc

•

Deployment

•

Web applications

•

Enterprise JavaBeans™ development

•

Optimizeit™ Suite

•

TeamSource™ DSP (Development Services Platform)
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JBuilder™

The JBuilder 7 environment supports development, testing, and

•

Magnifying glass button: click this to open ClassInsight.™

debugging of applications that take advantage of JDK® 1.4 features

•

Question mark button: click this to open the Compiler

like the new assert keyword. In order to provide the best

error message help file.

possible customer experience, JBuilder 7 is hosted on

Switch dialog box

JDK 1.3.1.

The Switch dialog box allows you to switch quickly from one open

Productivity enhancements

file to another. Press Ctrl+b to invoke the Switch dialog box. All
open files load in the list. Type a file name to narrow the list. You

JBuilder 7 provides a number of productivity enhancements. One

can select directly from the list. The selected file becomes the

of them is apparent when you first start JBuilder: the Configure

active one in the editor.

File Associations dialog box. This allows you to associate file types
with JBuilder so that they open in JBuilder by default.

Brace matching

In the Configure File Associations dialog box, you can choose file

Select a brace to see that brace and its partner highlighted. Set

types to associate with JBuilder. Choose from:

Brace Match options in Tools|Editor Options, Editor page, Editor

•

Java™ class file (.class)

Options field. Change the color scheme in the Color page of

•

Java source file (.java)

Tools|Editor Options.

•

JBuilder project (.jpr, .jpx)

•

Change these settings by selecting Tools|Configure File

Indenting

Associations.

Smart Indent behaves more intelligently in three important ways:

Other productivity enhancements include helpful editor

•

enhancements, additions, and various improvements to search and

The cursor can be anywhere in the line for the entire line to
be indented.

find functionality.

•

It nests new lines in the appropriate number of columns
after an opening curly brace.

Editor enhancements

•

Error handling

With the Smart Paste option checked, lines that are pasted
in are indented appropriately in the new location.

Change indent options on the Editor page of Tools|Editor

ErrorInsight™ performs a second pass for deeper errors. It flags

Options. The behavior used by Smart Indent in older editions of

missing imports, captures syntax errors such as missing semicolons,

JBuilder is still available from this page: deselect Smart Indent and

and catches agreement problems such as type mismatches and

select Use Classic Behavior For Smart Indent.

method signature mismatches.
Syntax errors are underlined in the editor. JBuilder uses red zigzags

Single-click tab closure

by default. You can change the color scheme in Tools|Editor

Click the X icon on a tab or in the project toolbar to close the tab's

Options by choosing the Color page.

associated file, message, or project. A whole X means that the file

Place your cursor over the syntax error to display a Tooltip that

is unchanged or that the message does not require attention. A

indicates the nature of the error. The Tooltip contains one of two

broken X means that the file has changed or that the message

buttons, depending on the nature of the error:

contains new information.
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Pane control

Toolbar search

View|Hide All and View|Show All replace View|Toggle Curtain.

Type the text you want to search for in the Find icon's combobox

The menu item name toggles appropriately between Hide All and

and press Enter. JBuilder scrolls to and highlights the line of code

Show All, depending on the state of the panes:

containing the text you searched for.

•

If all panes are visible, the menu item is View|Hide All.

Press F3 to search again forward. Press Shift+F3 to search

Selecting it hides the project, structure, and message panes.

again backward. Previous search strings are available from the

The message pane reappears when needed and can be

popup menu.

individually closed by clicking its X icon.
•

If the content pane alone is visible, the menu item is

Replace In Path

View|Show All. Selecting it reveals the project and structure

Select Search|Replace In Path to invoke the Replace In Path

panes. The message pane reappears when needed.

dialog box. It offers the same set of options and parameters as the
Find In Path dialog box, with the Replace option checked.

Shortcuts and searching
Project|Add Files/Packages

Build system

A new Classes page has been added so you can quickly find classes

Build features vary by JBuilder edition.

to add to your project. Enter a name in the Search For field and a

The build system of JBuilder is based on Apache™ Ant, an open-

list of matching classes is loaded dynamically.

source, Java-based build tool, and is also extensible as an
OpenTool. The build system has several advantages and allows

Favorites folder

you to:

The file selection dialog box, which is used for File|Open,

•

Build projects with Ant.

•

Extend the build system with an OpenTool.

in a scrollable pane below the other existing shortcuts on the left

•

Specify dependencies between build targets.

side of the dialog box.

•

Create external build tasks, such as shell/console

File|Add, and in other areas, now has a Favorites folder in the
upper right corner. Anything added to the Favorites folder displays

commands, to execute during the build process with the

To add a custom favorite to the shortcuts, choose the down arrow

External Build Task wizard.

next to the Favorites folder on the toolbar and choose Add
To Favorites.

Find Classes dialog box
Find Classes supersedes Browse Classes. To invoke Find Classes,

•

Convert SQLj files to Java source files.

•

Filter packages and exclude them from the build process.

•

Add build targets to the Project menu and the toolbar.

•

Use Clean to remove build output.

select Search|Find Classes or type either Ctrl+Minus sign

Wizards related to the build system, such as the External Build

or Ctrl+Hyphen and start typing the name of the file you want

Task wizard, are on the Build page of the object gallery (File|New).

to open. Classes with names matching what you type are loaded in

For more information on these features, see "Building and

the Matching Classes list. Choose the class or classes you want

compiling Java programs" in Building Applications with JBuilder in the

to open and click OK. The source of those classes opens in

JBuilder documentation.

the editor.
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For more information on extending the build system, see "JBuilder

SQLj

build system concepts" in the JBuilder OpenTools documentation.

This is a feature of JBuilder Enterprise.
JBuilder now recognizes .sqlj files in the build process. Use

Running external Apache™ Ant files

Tools|Enterprise Setup|SQLj to configure your IBM® DB2® or

This is a feature of JBuilder Enterprise.

Oracle® SQLj by pointing to the SQLj executable. In the Project

If you have an existing project that already uses Ant, you can run

Properties, you can specify which SQLj translator should be active

Ant within JBuilder. JBuilder automatically recognizes

for the project.

build.xml files as Ant files. When you add a build.xml to

Once your project has an active SQLj translator, SQLj is run

your project (Project|Add Files/Packages), the node displays with

against any .sqlj files in your project as part of the build

an Ant icon instead of the usual XML icon. The targets in the

process, and the generated .java files appear as children of the

build.xml file are displayed as child nodes.

SQLj node. The generated .java files are then compiled as part
of the overall build process.

Note: You can use a name other than build.xml , but you must
modify the properties of the XML file for JBuilder to recognize it
as an Ant build file. Right-click the XML file in the project pane

Filtering packages

and choose Properties. Choose the Ant tab and select the Ant

This is a feature of JBuilder SE and Enterprise.

Build File option.

JBuilder provides a new feature that allows you to exclude

If you right-click a build.xml file in the project pane and

packages from the build process. However, if the Dependency

choose Make, then Ant is run against the file using the file's

Checker determines that there is a dependency on classes in the

default target. If you select one or more of its target nodes, Ant is

excluded packages, those classes are compiled.

run against the file using the selected targets. Output from the Ant

The automatic source packages feature must be enabled on the

run is routed to the Ant tab of the JBuilder message pane. You can

General page of the Project Properties dialog box (Project|Project

navigate to files with errors in them by clicking on the error

Properties) to use the package filtering feature. A <Project

messages in the message pane.

Source> node also displays at the top of the project pane when the
automatic source packages feature is enabled. This node contains

External Build Task wizard

all the source packages and source files in the project, except

This is a feature of JBuilder Enterprise.

packages and files that have been added manually. You can use this

Use the External Build Task wizard to create external build tasks,

node to quickly filter source packages. Right-click the <Project

such as shell/console commands, to execute during the build

Source> node, choose Apply Filter, then choose one of the

process. For example, you might have a .BAT or .EXE on

submenu commands.

Windows® or a .sh or executable on Linux® or UNIX that you

To exclude packages, right-click a package or packages, choose

want to execute every time you do a build. The External Build Task

Apply Filter, and choose a command from the submenu. Filtered

wizard is located on the Wizards menu and on the Build page of

packages appear in a Package Filters folder in the project pane. To

the object gallery.

remove filters and include the packages in the build system, rightclick the Package Filters folder and choose Remove All Filters.
You can also expand the Package Filters folder and selectively
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include packages. The Apply Filter and Remove All Filters

menu, the first target in the list displays on the toolbar and

commands are also available on the Project menu.

additional targets display on the drop-down list.

Manually added packages and files can't be excluded with the
Apply Filter command. You must remove them from the project

Build page of Project Properties

to exclude them from the build process. Also, any buildable nodes

The Build page of the Project Properties has new tabs: These are

that are children of the project node, such as Java source files

features of JBuilder Enterprise.

added by wizards, are compiled and can't be excluded unless you

•

SQLj: specify the SQLj translator.

•

Ant: add custom Ant libraries containing your own build

remove them from the project. Essentially, any files or packages
that display above the Package Filters folder are not filtered and are

tasks and use a different version of Ant by adding a library

included in the build process.

with the Ant JARs.
•

Changes to build menus

Menu Items: configure the Project menu.

Building from the command-line

Configuring the Project menu

This is a feature of JBuilder SE and Enterprise.

This is a feature of JBuilder Enterprise.

The JBuilder command-line -build option has been modified to

For convenience, JBuilder allows you to configure the first group

accept build targets as arguments. You can now specify one or

of the Project menu. You can change the order of targets and add

more targets, which are executed in the order listed. If a target isn't

additional targets, such as Clean, external build tasks, and Ant

specified, Make is the default target.

targets. Configuring the Project menu also configures the toolbar.
Choose Project|Project Properties|Build|Menu Items to

Among the -build arguments, projects are distinguished from

configure the Project menu.

targets by the the .jpx or .jpr extension. Any argument that
ends with .jpx or .jpr is assumed to be a project; any argument

To configure the Project menu for future projects, make the

that doesn't have these extensions is assumed to be a target name.

changes in the Default Project Properties.

The command is in this form:

Project pane context menu

jbuilder -build <project1.jpx> [ [<target1> <target2> ...]

The Clean command has been added to the project pane's context

[<project2.jpx> [<target3> ...] ] ... ]

menu. Clean removes all build output, such as the classes
For example:

directory, JARs, and so on. Right-click the project file and choose
Clean to remove the entire project's build output. To clean

jbuilder -build myproject.jpx rebuild

individual files, rather than the entire project, select them in the
project pane, right-click, and choose Clean. As with the Make and

jbuilder -build myproject.jpx clean make myotherproject.jpx

Rebuild commands, Clean only appears on the context menu when
appropriate nodes are selected.

For more information on this option, see "JBuilder command-line
arguments" in Building Applications with JBuilder in the JBuilder

Toolbar changes

documentation.

By default, Make is on the main toolbar and Rebuild is now on the
drop-down list next to Make. If you add any targets to the Project
5
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Each runnable file's runtime configuration can be used to run other

Runtime configurations

files of the same type. For instance, a configuration made for one

The interface for tailoring running and debugging configurations

applet can be used to run other applets.

and for selecting among configurations has changed. Available
features vary by JBuilder edition.

Runtime keybindings

The Run page of the Project Properties dialog box displays the

F9 runs the active project using the default configuration.

available configurations. There are two ways to access this page:

Shift+F9 debugs the active project using the default

select Project|Project Properties and choose the Run page, or

configuration. If no default configuration is specified, the Project

select Run|Configurations.
•

Properties|Run page appears. Select or create a configuration and

Click New in the Run page to access the Runtime

click OK. Press the keystrokes again to run or debug the project

Properties dialog box. Create a configuration for running,

using that configuration. This does not make the new configuration

debugging, or optimizing a project or runnable file.

the default.

•

In JBuilder Personal: Only one configuration at
a time is supported, but that configuration is

Tool configurations

completely editable.
•

A program that you add to the Tools menu of JBuilder can run as

In JBuilder SE and Enterprise: Multiple configurations

an external tool or as a service within JBuilder. When you run a

are supported. All are editable.
•

program as an external tool, you can shut down JBuilder and the

The Debug page of the Project Properties box is now part

tool continues to run. When you run a program as a service, its

of the Runtime Properties dialog box.

output appears in the message pane. You can stop the service by
clicking the red Stop button on the message pane's tab, and you

You can tailor configurations in the following ways:
•

can start it again by clicking its green Run button. If you attempt to

Specify which configuration is the default. (In JBuilder

exit JBuilder without stopping the service first, a message box

Personal, the existing configuration is always the default.)

appears asking if you want to terminate the service. If you decide

•

Associate a build target with run and debug configurations.

to terminate the service, it stops and you exit JBuilder; otherwise

•

Determine which configurations appear as choices on the

the service keeps running and JBuilder does not exit.

Run and Debug context menus. This is a feature of JBuilder
SE and Enterprise. These configurations show in submenus

Debugger

in the following locations:
•

On the project pane context menu.

•

On the Run menu, either as menu items or submenus,

The following debugger enhancements have been added to
JBuilder 7:

Debugger options

depending on context.
•

You now set debugger options, such as SmartStep settings and

Delete all configurations, including the default.

remote debugging options, through a runtime configuration. A
All runtime configurations for a file or project are listed in the

runtime configuration is a set of pre-configured parameters. Using

Run menu.

preset parameters saves you time when running and debugging,
because you only have to set the parameters once.

Some wizards that generate runnable files prompt you to configure
runtime/debugging properties for that file, if no configuration for

You use the Debug page of the Runtime Properties dialog box to

that file type exists.

set debug options. To display this page, choose
6
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Run|Configurations, then New or choose Project|properties,

UML™Code Visualization

then choose the Run tab and click the New button. On the

This is a feature of JBuilder Enterprise.

Runtime Properties dialog box, click the Debug tab. Debug

The UML browser now displays Java source files dynamically even

options have not changed.

if they haven't been compiled, but only if they are on the source
path. A message displays in the UML browser indicating that the

Classes With Tracing Disabled

UML diagram may not be accurate. However, if a source file isn't

The Classes With Tracing Disabled view and dialog box are now

on the source path, the .class file must be generated first. A

available in all JBuilder editions.

message prompts you to compile the project to generate the class

In JBuilder Personal, three basic classes (java.lang.Object,

files for the UML diagram. If the class files are out of date, for
example the source file has been changed but hasn't been

java.lang.String and java.lang.ClassLoader) are

recompiled, a message displays in the UML browser indicating that

available. You cannot add, modify, or delete classes; however, you

the UML diagram may not be accurate. For an up-to-date and

can choose to step or not step into those classes.

accurate UML diagram, it's always best to compile before you
SmartStep configuration is now available in all JBuilder editions.

choose the UML tab.
The UML browser now recognizes reverse dependencies from

Evaluate/Modify dialog box

classes to JSPs. For example, a bean generated by the JSP™ wizard

You use the Evaluate/Modify dialog box (Run|Evaluate/Modify)

can now link to the JSP that uses it. It doesn't have to be a JSP

to evaluate expressions, change the values of data items, and

bean; it could be any class that the JSP uses.

evaluate method calls. CodeInsight™ and syntax highlighting
features now display when you enter an expression into the

Printing support

Expression field.

File|Print now supports larger paper sizes for printing large UML
diagrams: A1 (594 mm x 841 mm) and A0 (841 mm x 1189 mm).

Remote debugging
This is a feature of JBuilder Enterprise.

JBuilder™ Test Runner

The default address when attaching to a remote computer has been

This is a feature of JBuilder Enterprise.

changed to 3999.

Improvements have been made to the GUI of the JBuilder

For more information on debugging, see the following chapters in

Test Runner:

Building Applications with JBuilder in the JBuilder documentation.
•

"Debugging Java programs"

•

"Remote debugging"

•

A new progress bar indicates the percentage of
tests completed.

•

Text output and icons have been improved.

•

Now you can right click any node in the Test Hierarchy
page or the Test Failures page of the JBuilder Test Runner
and choose Run Selected or Debug Selected. This is useful
when you want to investigate a test failure.

For more information on JBuilder Test Runner, see "Unit Testing"
in Building Applications with JBuilder in the JBuilder documentation.
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option. The option generates documentation for @use tags in your

Refactoring

source code. It generates one Use page for each package and a

This is a feature of JBuilder SE and Enterprise. The following new

separate one for each class and interface. The package use file is

refactoring features have been added to JBuilder 7:

called package-use.html; the class use file is classuse/classname.html. This page describes what packages,

New refactoring features
Feature

Description

Extract method

Turns a selected code fragment

classes, methods, constructors, and fields use any part of the given
class, interface, or package. The option is ignored for the JDK 1.1
doclet type.

into a method.
Change method parameter

To delete all HTML files in the configured doc directory, choose

Adds, renames, deletes, and re-

the Clean build target. Choose Rebuild to clean the directory

orders a method's parameters.
Introduce variable

first, then rebuild the HTML files.

Replaces the result of a

For more information on Javadoc, see "Creating Javadoc from API

complex expression, or part of

source files" in Building Applications with JBuilder.

the expression, with a
temporary variable name.
Surround with try/catch

Adds a try/catch statement

Deployment

around the selected block of

These are features of JBuilder SE and Enterprise.

code.

Archive Builder™
The Archive Builder™ has been moved to the Build page of the

Refactoring commands have now been added to the Edit menu.

object gallery.

Warnings are now displayed for EJB™ refactorings. You will need

The Archive Builder has a new archive type, Native Executable,

to update all relevant source files to support the refactoring.

that can be used to bundle an application JAR file with native

The Refactoring tab now displays a open X to visually indicate that

executable wrappers for Windows, Linux, Solaris,™ and Mac® OS

a refactoring has not yet been completed. When the refactoring is

X. Several other archive types, such as Application and J2EE™

finished, the X is closed.

Application Client, also provide this feature. See “Native

For more information on refactoring, see "Refactoring

Executable Builder” below.

code symbols" in Building Applications with JBuilder in the

Selecting a method for determining the application's
main class

JBuilder documentation.

Due to the changes in runtime configurations, this step has

Javadoc

changed. The first option, Determine Main Class From Runtime

This is a feature of JBuilder SE and Enterprise.

Configurations, has this behavior:

You can now use the the project JDK when running Javadoc

•

Uses the main class specified in the runtime configuration

instead of the JDK that hosts JBuilder. For example, if your project

set as the default on the Run page of the Project Properties

uses JDK 1.4, you can run that version of Javadoc instead of JDK

dialog box.

1.3.1, the version that hosts JBuilder.

•

Uses the first configuration in the list if a default runtime
isn't specified on the Run page.

On the specify doclet command-line options page of the wizard,
the @use option has been moved to the Generate "Use" page
8
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•

Doesn't specify a main class if an application runtime

Choosing the Mac OS X option creates an application that is

doesn't exist or the one selected doesn't have a main class.

launchable only from a command line. In order to create an

Caution: If a main class isn't specified, the following

application that is launchable from the Finder, Mac users need to

won't execute:

create an application bundle. Please refer to the Apple Mac OS X

•

Launching native executables

Developer documentation with regards to bundles and

•

Using java -jar <jarname> from the

application packaging.

command-line
•

Web applications

Double-clicking a JAR

Web development is a feature of JBuilder Enterprise. Applet

Deleting contents of an archive node

development is a feature of all editions of JBuilder.

The Remove Generated Files command on the project pane's
context menu has been replaced with the Clean command. Right-

The following new Web applications features have been added

click the archive node and choose Clean to remove the node

to JBuilder 7:

contents but not the node itself.

Server configuration
If you are not using the Borland® Enterprise Server, Tomcat 4.0 is

Native Executable Builder

the default server. To enable the Apache Tomcat configuration,

The Native Executable Builder, available on the Wizards menu and

1.

the Build page of the object gallery, is a shortcut to the new Native

Open the Configure Servers dialog box (Tools|Configure
Servers).

Executable archive type. This wizard bundles an application JAR
file with native executable wrappers for Windows, Linux, Solaris,

2.

In the tree on the left, choose Tomcat 4.0.

and Mac OS X.

3.

Click Enable Server at the top of the right side of the
dialog box.

Important: Because the JDK is not bundled with the JAR file,

4.

it must be installed on the user's computer in order to run
the executable.

Click OK.

Project configuration
When you run your servlet or JSP, you now need to configure a

Running executables

single server or modular services for the project.

Note that the JDK is not bundled with the JAR file, so the JDK

To configure a single server for your project:

must be installed on the user's computer in order for the
executable to run. The platform-specific executable file looks for

1.

Open the Server page of the Project Properties dialog box.

the installed JDK in the following location:

2.

Select the Single Server For All Services In Project

•

Windows: Registry.

•

Linux/Solaris: JAVA_HOME environment variable and the

option.
3.

•

user's path.
•

Select the server from the drop-down list.
If you want to avoid having libraries added to your
project that you won't use, uncheck the check box in

Mac OS X: pre-defined location for the JDK.

front of the service(s) you don't need in the Services

If you create the executable on the Windows platform and move it

list. If you disable services, the corresponding JBuilder

to other platforms, you may need to change the permissions to

features will be disabled. For example, if you turn off

make it executable.
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•

the JSP/Servlet service, most of the Web wizards and

for this configuration is on the Runtime Properties Server page.

the JSP compilation feature are disabled.

For applets, the configuration UI is on the Runtime Properties

If you want to make changes to the configuration

Applet page.

settings for the selected server, click the ellipsis button
and edit the settings you want on the General and

Web applications wizards

Custom pages. Click OK when you're finished.

The Applet, JSP, and Servlet wizards now contain a
Define runtime configuration page where you create a

To use different servers for different services:

runtime configuration.

1.

Open the Server page of the Project Properties dialog box.

For more information on Web applications, see "Developing Web

2.

Select the Modular Services Provided By Different

applications" in the Web Applications Developer's Guide in the

Servers option.

JBuilder documentation.

•

If you want to avoid having libraries added to your

Enterprise JavaBeans™ development

project that you won't use, uncheck the check box in
front of the service(s) you don't need in the Services

•

list. If you disable services, the corresponding JBuilder

EJB™ designer improvements

features will be disabled. For example, if you turn off

The EJB designer includes several improvements:

the JSP/Servlet service, most of the Web wizards and

•

which help you organize and develop complex EJB projects.

Update the configuration for the selected service on the

While your EJB module can contain many enterprise beans,

right side of the dialog box. Depending on the selected

only the ones on the current view are visible at any one time

server/service, this information may be able to be

in the EJB Designer.

configured or may be read-only.
•

•

You can quickly arrange the bean representations on a view

To use a selected Web server, click the JSP/Servlet

with a single menu command, Views|Arrange EJBs. The

service. In the Server drop-down list on the right side

bean representations are automatically arranged in a

of the dialog box, select the Web server you want to

logical pattern.

use. If you want to make changes to the configuration

•

The EJB Designer context menus have been redesigned.

settings for the Web server, click the ellipsis button and

•

The EJB Designer has a toolbar that contains icons for the

edit the settings you want on the General page. Click

menu commands.

OK when you're finished.
3.

You can group sets of Enterprise Javabeans with views ,

the JSP compilation feature are disabled.

•

Click OK again to close the Servers page.

You can add new ejbCreate methods to a bean using the
EJB Designer, and you can use a bean's inspector to add
and modify parameters of an ejbCreate method.

Runtime configuration

•

You now Web run and Web debug through a Web run

You can import an enterprise bean into an EJB module
using the EJB Designer. You'll find this useful if you want

configuration. You can create the configuration when you create an

to import a bean from one EJB module to another or if

applet, servlet or JSP with a wizard. You can also create a

you've obtained a bean that has no accompanying

configuration with the Run Configurations dialog box.

deployment descriptors.

For servlets and JSPs, the configuration consists of two parts—the
server configuration and the servlet or JSP configuration. The UI
10
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•
•

The EJB Designer can get you started developing entity

Configuring and selecting a server

beans with bean-managed persistence (BMP).

You now configure the servers you are going to use for EJB

You can use the EJB Designer to design your entity beans,

development using the Tools|Configure Servers dialog box.

then use the Create Schema From Selection menu

How you select a server for EJB development has changed. Use

command or icon on the toolbar to create a schema from

Project|Project Properties and click the Server tab to use the

the beans you designed.

Server page to make your selection. You can select a single server
for all of your development needs, or you can specify different

Wizards

servers for different services. For example, you might choose one

The EJB Module From Descriptors wizard can import vendor-

server to provide EJB services and another to provide JSP/Servlet

specific information in Borland and BEA® WebLogic® deployment

services for your Web development.

descriptor files when creating an EJB module. It can also detect
and update your project source directories using class names in
the descriptors.

More flexible runtime configurations
for the server

The new Project From Existing Code wizard can identify EJB

To create a runtime configuration to run the server within JBuilder,

deployment descriptor files and import vendor-specific

choose Run|Configurations and click the Run tab, click the

information in Borland and BEA WebLogic descriptors to create

New button, then click the Server tab, which replaces the EJB tab

EJB modules for your new project. The wizard is on the Project

in previous JBuilder releases. Using the Server page, you can decide

page of the object gallery.

exactly which services you need when you run the server and
eliminate unneeded ones. You can also customize the runtime

Saving a copy of the deployment
descriptors

configuration command-line, the archives to be deployed, libraries,
launch URI for JSPs and servlets, and so on.

You can choose to save a copy of the deployment descriptors in
their current state each time you save an EJB or EAR module by

Optimizeit™ Suite

setting the new Copy Descriptors option. To find this option,

JBuilder 7 provides tight integration with Borland Optimizeit Suite,

right-click the EJB or EAR module node in the project pane,

a complete performance solution for Java.

choose Properties, click the Build tab, and select the EJB or

•

EAR page.

Optimizeit™ Profiler: Helps you find and fix Java memory
leaks, CPU bottlenecks, and excessive temporary object use.

•

Server support

Optimizeit™ Thread Debugger: Checks the progress of all

JBuilder now supports Borland® Enterprise Server, AppServer™

threads running in an application to assure speed and

Edition 5.0.2.

reliability of code.
•

JBuilder has improved support for WebLogic 6.x+ servers

Optimizeit™ Code Coverage: Lets you visually monitor
classes and methods in your code and assure applications

including WebLogic 7.0. It also has improved support for IBM®

are ready to deploy.

WebSphere® 4.0 and iPlanet™ 6.x+ servers.

Optimizeit Suite features are available on the following JBuilder
menus and dialog boxes:
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•

Run|Optimize Program

•

Web Optimize

JBuilder™

•

Runtime Properties|Optimize tab|Profiler page

•

Conclusion

Runtime Properties|Optimize tab|Code Coverage page

Increase productivity with the leading cross-platform Java

•

Runtime Properties|Optimize tab|Thread Debugger page

development environment. The JBuilder development

From within Optimizeit Suite, you can return to JBuilder 7 by

environment significiantly enchances developer productivity with

clicking the JBuilder button on the source code window; this

timesaving tools that speed time-to-market. Leverage existing

returns you to JBuilder with your tested code in the content pane.

projects and reduce development costs with a two-way visual EJB

Go to http://www.borland.com/optimizeit/ for more information

2.0 designer, UML code visualization, refactoring, unit testing and

on purchasing and installing Optimizeit.

more. The enhanced JBuilder provides a flexible, open solution for
developing and deloying Java applications.

TeamSource™ DSP (Development
Services Platform)

For more information on JBuilder 7, please visit our Web site at

The TeamSource DSP plug-in is a feature of JBuilder SE

http://www.borland.com/jbuilder.

and Enterprise.
Borland TeamSource DSP (Development Services Platform) is a
collaborative product development platform for distributed
teams—whether they are down the street or around the world.
TeamSource is one of the first secure software collaboration
solutions based on an Internet architecture that cuts across
firewalls. It combines essential source code management features
(storage, versioning, and file sharing) with integrated business
messaging (secure, archived, channel-based communications that
are integrated into the development process) to unite teams across
functions, locations, and companies. For a limited time, JBuilder
SE and Enterprise will include a free 90-day trial of TeamSource!
For information on the trial, see teamsource.html in the
offer/teamsource directory on your JBuilder CD.
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